Spatial Audio Workstation 2
Operation Manual
GETTING STARTED

INTRODUCTION

Welcome to the IOSONO Spatial Audio Workstation. The Spatial Audio Workstation is more than just another surround panner. Multiple sound sources can be viewed in one surround editor and multiple surround configurations can be used with the same automation data. It allows you to move sound in ways no other panning software can. This manual will describe how to use the Spatial Audio Workstation in creating compelling surround sound mixes that will translate to multiple speaker configurations.

The Spatial Audio Workstation uses an object-based system to manipulate sound sources within the listening area experienced by the audience. Objects can be moved around the listening environment, regardless of the speaker configuration. The paths that Objects move on can be precisely edited. The positioning and motion of sound sources can be created in any surround configuration and the detail of that motion will be retained on more complex playback systems. No other software can provide this type of translation between various speaker systems. With this ability, editors may create placement and motion information that can be further refined during the mixing process in whatever format is required for delivery.

SYSTEM REQUIREMENTS

The Spatial Audio Workstation plug-in runs inside of Steinberg’s Nuendo DAW software running under Windows. The Spatial Audio Workstation’s sophisticated processing needs to be tightly integrated into the DAW to provide seamless usability to the user. The Spatial Audio Workstation is not a VST plug-in typical of Steinberg systems. It is a “program plug-in” as defined by Steinberg and, when installed, can be found listed in the Plug-in Information window under the Program Plug-ins tab.

Minimum Requirements

- Operating System: Windows XP Professional SP3, Windows 7
- Host application: Nuendo 5 (32 bit)
- Processor: Dual core 2.4 Ghz
- Graphic board: Open-GL support recommended
- Sound card: ASIO, at least 6 output channels recommended
- Display: Resolution 1280 x 1024 pixels, dual display recommended

INSTALLATION

Installation is straightforward. Nuendo should not be running during installation. Just follow the instructions found in the installation download. Once installation is complete, open Nuendo and go to the Plug-in Information window found under the Devices menu. Click on the Program Plug-Ins tab to make sure that the Spatial Audio Workstation is listed there and is checked active.
Only activate or de-activate the Spatial Audio Workstation while no Nuendo projects are open.

Once active, the Spatial Audio Workstation is available from the Project menu. Select it and the Spatial Audio Workstation plug-in graphic user interface (GUI) will open up. The GUI is large, more like a full program than just a plug-in. There are menus available for various functions including Settings that will be used to configure the Spatial Audio Workstation for your particular surround setup.

**SETTINGS MENU**

The Settings menu found in the Spatial Audio Workstation GUI has two options:

- **Project Settings**
  
  *These settings are specific to each Spatial Audio Workstation project that you create and are saved with the project data in the Nuendo file (.npr).*

- **Preferences**
  
  *These settings are global and are retained regardless of what Nuendo project is active.*

**PROJECT SETTINGS**

The Active Bus Arrangement pull-down menu selects what type of surround speaker configuration you are using with the Spatial Audio Workstation. This determines how the position of Objects in the Spatial Audio Workstation are presented to the audio outputs of your DAW. You can change the Active Bus Arrangement without affecting how the Spatial Audio Workstation operates or any existing automation. This allows you to work in several different surround configurations without altering panning data and automation.

The setting “automatic scene scaling” should only be used in conjunction with the IOSONO IPC100 Spatial Audio Processor. See the manual of the Spatial Audio Processor for more details on automatic scene scaling.
**Background**

For each SAW project you can set a background image of any size in .png and .svg format, which is then drawn underneath all SAW Objects. This “virtual room” can be centered and scaled to have the proper relationship to the listening area and the grid in the SAW. Any background image can be set as default for all SAW projects by clicking “set as default”. The background image is stored within the Nuendo project file (*.npr) and will be visible when the project is opened with SAW Version 2.2.2 or higher.

**Automatic Decay Radius**

The automatic decay begins to function at a preset radius from the center of the listening area. Its value uses the selected units in the Preferences/General tab. The stage visualization can be toggled on and off from the view menu or the stage context menu.

**PREFERENCES**

From the Spatial Audio Workstation GUI, choose Settings -->Preferences to open the Preferences window. There are three tabs that contain various settings. These settings will be retained globally and will not change with each Nuendo project.

**General**

*Under the General tab, you can define the GUI measurement unit that is used in the stage view.*

- **GUI Unit**

  The measuring unit of the Spatial Audio Workstation’s stage can be set to meter, millimeter, inch or foot. Changing this setting does not affect the operation of the Spatial Audio Workstation or projects that were created using another measurement standard. It only alters how space is measured in the GUI.

**Stage View**

*The View tab allows you to customize the way parts of the GUI appear.*
• Colors
  Clicking on any one of the color swatches will bring up a color selector tool that you can use to customize the way things look in the Spatial Audio Workstation.

• Horizontal step size
  The value here determines what the distance is between each horizontal line of the grid.

• Vertical step size
  The value here determines what the distance is between each vertical line of the grid.

• Show axes
  The axes (X, Y) define the position of the listener on the Stage. When the axes are visible, you can reference the listening position easily.

• Axes style
  This pull-down menu has six choices for how the axes lines are drawn: dot line, dash line etc.

**Shortcuts**

The Shortcuts tab contains a list of key commands for faster operation of the Spatial Audio Workstation. These key commands only work when the Spatial Audio Workstation is the active window in Nuendo. Otherwise, key commands will be directed to the Nuendo GUI.

**NUENDO VST OUTPUT CONFIGURATION**

The Spatial Audio Workstation automatically creates its own VST Output bus named „IOSONO Internal Mix“. This bus will match the channel configuration chosen in Project Settings. This output bus can be routed to the physical outputs of your system that connect to your speakers or if it is set as the „Main Mix“ in VST connections, you may use the control room feature to route the signals to your speaker system. When completed, your VST Outputs should look something like the figure below. Once the VST Outputs have been configured, you are ready to start creating Objects and placing sound sources within the Stage view.
OVERVIEW OF THE SPATIAL AUDIO WORKSTATION GUI

The Spatial Audio Workstation interface is available from the Project menu in Nuendo. It is rather large and for best use, should have a dedicated monitor for best results. When you first open the window, it will not contain any objects and be fairly blank except for the speaker icons. The figure below shows the Spatial Audio Workstation populated with several different object types to illustrate the components of the GUI.

1. Stage View
   This area of the GUI represents the listener's soundfield. A dimensional grid details the physical position of sound sources in user-determined increments (feet, inches, meters and millimeters). The speaker configuration is represented by icons shown in their standard positions for the active bus arrangement.

2. Spatial Audio Workstation Objects
   There are several types of Spatial Audio Workstation Objects. Each one can be manipulated and positioned independently of the others.

3. The Spatial Audio Workstation Tools
   These tools allow you to zoom in and out of the Stage, select various operating modes, edit aspects of motion paths and more.

4. Object Parameters
This section of the GUI contains all the parameters of the currently selected Object. Each parameter can be automated just like any other plug-in in Nuendo. This is how you achieve motion of sound in the Spatial Audio Workstation.

5. Speaker Icons

The speaker icons are arranged in standard configurations based on the active bus arrangement setting.

6. Object List

Each Object created in a project will be listed here including Channel, Event and Group Objects.

7. Layers

Spatial Audio Workstation projects may get very complex. Layers are used to organize Objects into manageable collections of related Objects.

8. Motion Path

Paths are the routes that objects follow as they move in the stage view.

SPATIAL AUDIO WORKSTATION DATA

The data that is created in the Spatial Audio Workstation is saved inside the Nuendo project. This happens automatically when the Nuendo project is saved. No additional action is necessary to preserve this data. It is recommended that you always backup all your data. Simply copying the Nuendo project folder to a secure location will protect the data it contains.

Be aware that any Nuendo project that contains Spatial Audio Workstation data, should not be edited or opened while the program plug-in is not active or installed. This may cause unpredictable behavior and possible corruption of the data.

MARKERS AND GUIDES

Multiple markers and horizontal or vertical guides may be placed on the stage to aid in positioning and moving Objects. Each marker and guide can be colored individually. Markers may also be named. Markers and guides may be created from the View menu or by right-clicking in empty space within the stage.

- When you select „New marker“ the dialog will allow you to enter a name and description and choose a color for the marker. The marker will appear where you last clicked in the stage.
- When you select „New guide“ the dialog offers choices of horizontal, vertical, X or Y position, line style and color.

Markers and guides may be moved around the stage once they are created. When they are in a final position, they can be locked in place to prevent further editing from the View menu and stage contextual menu.
Objects are the sound sources in the Spatial Audio Workstation. There are two basic types of Objects: Channel Objects and Event Objects. Channel Objects are sources of audio that may contain one or more sounds mixed together but coming from one location in the listening area. You may think of this as a virtual speaker that may be moved around the listener. Conversely, Event Objects are singular sounds that have a duration with specific start and end times. An Event Object only exists for a given period of time and can also move around the listening area. Channel and Event Objects can coexist in the same Nuendo project.

Group Objects contain one or more Event Objects that are linked together allowing them to be manipulated together as a single entity. Group Objects do not have any audio signals themselves but are used to control the positions of the members of the group.
CREATING OBJECTS

In order to create an Object in the Spatial Audio Workstation, you must first create a mono or stereo audio or group channel track in Nuendo. The Spatial Audio Workstation is capable of dealing with mono or stereo tracks. Mono tracks are presented as point sources or plane waves, stereo tracks result in Upmix Objects. Route the output of this track to the IOSONO Internal Mix bus. Then right-click on the surround panner in the mixer and select „IOSONO Spatial Panner“. As soon as you do this, you will see a new Channel Object appear in the stage.

All Objects are mono or stereo audio sources. Only mono or stereo audio or group channel tracks can be used to create Objects in the Spatial Audio Workstation.

Audio Track Mode: Channel or Event

Newly created audio tracks that are assigned to the IOSONO Internal Mix bus and using the spatial panner will default to being in channel mode. In channel mode, each track creates a single Channel Object. Only audio tracks are capable of being switched into event mode, whereby each audio event in the track creates a separate Event Object in the Spatial Audio Workstation. A single audio track may contain many Event Objects. Event Objects are further explained in “Event Objects” on page 10.

In order to change the track mode of an audio track in Nuendo, select one or more audio tracks and from the Project menu choose „SAW: Switch selected tracks to event mode“. Now all selected tracks will be in event mode. If any audio events are present on those tracks, Event Objects (one for each audio event) will appear in the stage view at their starting positions and in the Object...
Only audio tracks can be in event mode. Group channel tracks in Nuendo can only create Channel Objects. The track mode switching options in the Project menu will appear grayed out for selected group channel tracks.

CHANNEL OBJECTS

Channel Objects are like virtual speakers that can move anywhere within the stage. All audio that is coming through that audio or group channel track will be positioned where the Channel Object is in the stage. Using group channel tracks to create Channel Objects, multiple audio sources can be routed to that group channel and the resulting mix will be presented at the location of the Channel Object in the stage.

EVENT OBJECTS

Event Objects are more specialized than Channel Objects since they have a specific time duration in addition to spatial placement. In order to create Event Objects you must have an audio track in Nuendo routed to the IOSONO Internal Mix bus with the spatial panner set to Event Mode. Once an audio track is in Event Mode, any audio event placed or recorded in that track will create a corresponding Event Object in the Spatial Audio Workstation. Follow these steps to create multiple Event Objects on a single audio track in Nuendo:

1. Create a mono or stereo audio track in Nuendo and route it to the IOSONO Internal Mix bus.
2. Insert the IOSONO Panner by right-clicking on the pan control in the Mixer. This will first create a Channel Object.
3. Change from „Channel Mode“ to „Event Mode“ using the project menu in Nuendo.

A single Event Object
4. Either record a portion of audio or place an audio file from the Pool onto the audio track and an Event Object will be created in the Spatial Audio Workstation. You will see the Event Object icon in the Stage view and items in the Objects and Layers lists to the right.

5. Placing additional audio events on the same track will create more Event Objects. A new Event Object is created by each audio event on the track. Event Objects are only active (blue) when the cursor is between the start and end boundaries of that audio event.

Initially, each mono track Event Object is placed at the listening position in the center of the stage view. Upmix Objects appear at the position of the center speaker. All Event Objects are independent and can be moved anywhere in the stage view.

**UPMIX OBJECTS**
Upmix Objects are created for stereo audio or group tracks. They are not working like virtual speakers, they represent a sound field surrounding the listener. Upmix Objects transform stereo input to the surround configuration used in the project. Just like mono Objects, Upmix Objects can also be used in Channel or Event mode. For more details about Upmix Objects and their parameters, see “Upmix Object Parameters” on page 17.

**GROUP OBJECTS**
Once you have created more than one Event Object, you may join them together and form a Group Object. Group Objects allow you to control the placement and movement of more than one Event Object relative to the group’s center. Group Objects can be moved around the stage, causing all of the members to move relative to the Group Object icon.
Creating a Group Object:

1. Select two or more Event Objects in the stage. **Only Event Objects and other Group Objects may be grouped together.**

2. Placing the mouse over one of the selected Objects in the stage, right-click and choose “Group selected” from the contextual menu. **You may also choose the same option from the Edit menu of the Spatial Audio Workstation or use the shortcut Alt+G.**

3. You will see a newly created Group Object appear at the center of the Stage. **This Group Object now controls the relative positions of the two Event Objects.**
THE OBJECT LIST

The Object List in the Spatial Audio Workstation displays all of the Objects in the currently active Nuendo project along with controls for the status of each object.

The Object List

The first column in the Object list displays the name and icon for each Object. You may double-click on the name to change it. In the case of an Event Object, changing its name will also change the description field for the corresponding audio event in Nuendo. To the right, there are check boxes to enable the status of each Object as follows:

- Solo
- Mute
- Automation Read
- Automation Write
- Lock
- Visibility

OBJECT VISIBILITY

In the Objects list, there is a column for the visibility status of the object. There are three states of Object visibility:

- Visible
  When the check is dark, the Object will be seen on the Stage assuming its parent Group Object and Layer are visible as well.

- Invisible
  When the box is un-checked, the Object will not be seen on the Stage (except for selected objects, which are always visible)

- Auto-visible (Event Objects only)
  When the check is grey, Event Objects will only be visible when the play cursor is within their start
and end times.

- Members of Group Objects will follow the visibility of the Group Object unless they are already not visible.
- Visibility is also affected by the status of the layers. If a parent layer is not visible, child Objects will not be visible as well. For more information on layers, please refer to “Spatial Audio Workstation Automation” on page 23.

OBJECT LAYERS

Object layers are used to organize multiple objects into sensible groups. By default, a “Base layer” is created when you start a new Spatial Audio Workstation project. New layers may be added as needed.

To create a new, empty layer, choose “Add layer” from the Spatial Audio Workstation’s edit menu or right-click in empty space within the Layers list and choose “Add Layer.” You can then drag various objects into the layer as needed. Each layer can be renamed by double-clicking on its name in the Layers list. The “+/-” buttons open and close the layers and groups to reveal or hide their members.

It is also possible to create a new layer by selecting one or more Objects from the layers list and choosing “Move to new layer” from either the edit or contextual menus. This will move all selected Objects to a new layer. Objects may be moved between layers to reorganize them. Simply drag Object from one layer to another.

The layers tab
Each layer has locking and visibility controls in the form of check boxes in the layers list. Locking a layer will cause all Objects in that layer to become locked. This forms a convenient way to deal with projects that contain a large amount of Objects as the stage can become crowded if many Objects are visible at one time.

OBJECT PARAMETERS

Each Object in the Spatial Audio Workstation has many parameters associated with. That will be outlined in this section. Certain parameters are only associated with Event and Channel Objects while others are associated with Group Objects. Each of these parameters can be automated.

• Object Name
  In the upper left hand corner is a text field with the name of the selected object. You can edit the name in this field.

• Solo/Mute/Read/Write/Lock
  Allows you to set the status of currently selected Object(s)

• Volume
  You may adjust the volume of an Object in the Spatial Audio Workstation. This control is independent of any volume adjustment made in Nuendo and can be automated in real-time.

• LFE
  Similar to traditional LFE controls, this slider adjusts the amount of signal directed to the subwoofer system.

• Spread (Channel and Event only)
  This determines how much of the signal is directed to all speaker channels. At 100%, the signal will be equally distributed to all speaker channels. At 0%, the signal is directed only to the position of the Object in the stage. This parameter is not available for Group Objects.

• Delay
  This causes the signal to be delayed either manually or automatically according to the distance of the Object from the listening position. If Auto is enabled, the Spatial Audio Workstation will determine the natural amount of delay the signal should have for the distance the Object is from the listening position. As the Object moves around the Stage, this delay amount will change accordingly. The automatic delay is available for both mono Objects and Upmix Objects. Since Group

Object parameters for a mono Event Object

Spatial Audio Workstation Objects
Objects may have more than one member, only a manual delay setting is available for each Group.

- **Automatic Decay**
  Under the Distance tab you can activate an automatic volume and eq adjustment.

- **Cartesian Coordinates (X/Y)**
  Using grid values, Objects may be positioned using X and Y coordinates for very precise location.

- **Polar Position**
  Under the Polar tab, angle and distance values may also be used to position objects.

**OBJECT POSITION**

Objects can be positioned graphically using the Stage view’s GUI. Simply click and drag Objects in the Stage view to change their position. You may position Objects anywhere on the stage, including outside of the speaker icon array. The X and Y coordinates will update to reflect the position of Objects in the Stage view.

**Cartesian Coordinates**

Objects may also be positioned using X and Y coordinate values. The X and Y axes are defined by the listening position. In order to see these axes, choose Settings-->Preferences-->Stage View and check “Show axes.” Depending on what unit of measurement the grid has been set to in preferences, simply enter a value in meters, millimeters, feet or inches into the Cartesian coordinate fields to accurately place an Object anywhere in the listening space.

**Polar Positioning**

Objects can also be positioned using the angle and radius parameters found in the Polar tab. Angle determines the degree at which an object is placed relative to the center point of the Stage. The radius is the distance an object is from the center point. As the angle and radius parameters are adjusted, notice that the X and Y coordinates also change to reflect the new position.
AUTO DECAY

This control lets you select the volume decay and high frequency roll-off for each source according to its position on stage. Objects moving away from the center will then become more quiet and damped in high frequencies to simulate the inverse square law of radiation and air damping effects. The settings are available for mono as well as upmix sources.

Distance Dependent Volume

For each source you can set an automatic gain reduction by adjusting the decay factor between 0x and 4x. If the value is set to 0x, the distance dependent volume feature is effectively turned off. A decay value of 1x equals a natural decay in sound volume of -6dB per doubling of distance. A more steep decay setting will lead to a faster damping of the source.

When active, the distance dependent volume will behave like an offset to the “Volume” and “LFE” values for the object.

The total Volume of the source, which takes into account both the volume slider and calculated distance dependent gain, is then displayed in the top left corner of the Volume Decay tab.

Distance Dependent EQ

You can use the distance dependent EQ in addition to mimic air absorption effects for objects moving farther away by using a distance controlled high shelf filter. Similar to the Distance Dependent Volume, the gain of the filter will be adjusted per doubling of distance by the decay value set by the user.

Again, a value of 0x will turn off the feature.

Additionally, the cut-off frequency of the filter can be set from 250Hz to 20kHz.
The upmix algorithm extracts ambience signal components out of the stereo signal and allows to manipulate direct and ambience signals separately. The direct signals are arranged as a configurable stage while the ambience signals are placed around the listener.

The different parameters of the upmix can be adjusted using the object parameter controls at the bottom of the Spatial Audio Workstation window.

**Upmix Object Parameters**

Upmix Objects can be used to create surround signals out of regular stereo tracks. The different parameters of the upmix algorithm allow for different characteristics of the upmix, eg. width of the sound image, separation and control of direct and ambient signal components, rotation of the upmixed result, etc.

You can control the different upmix parameters when an Upmix Object is selected. To have a visual feedback of the current parameters, an upmix overlay can be displayed in the stage view. To activate the upmix overlay, click on the upmix stage overlay button. You can also activate the stage overlay by double-clicking the Upmix Object in the stage view. To hide the upmix overlay again, use the upmix stage overlay button or click outside the stage overlay in the stage view.

The upmix algorithm extracts ambience signal components out of the stereo signal and allows to manipulate direct and ambience signals separately. The direct signals are arranged as a configurable stage while the ambience signals are placed around the listener.

The different parameters of the upmix can be adjusted using the object parameter controls at the bottom of the Spatial Audio Workstation window.

**Upmix Parameters for Direct Signal Components**

- **Dry/Wet**
  
  This controls the amount of ambience in the stage defined by the stage width. Dry corresponds to more direct signal, whereas wet corresponds to more ambient signal.

- **Stage Width**
  
  Controls the width of the resulting stage in degrees. A maximum stage width of 180° is possible. Up to 90°, the width of the direct components in the stereo signal is adjusted, while values above 90° result in additional broadening of the direct signal components.

- **Rotation**
  
  The final result of the upmix can be rotated around the origin. All signal components, including direct and ambient signals, will be rotated. The rotation can also be adjusted by changing the position of the upmix icon in the stage view.
- **Divergence**
  This parameter controls whether the upmix should produce a stronger center signal between left and right or if the stereo signal should be upmixed evenly throughout the stage. A lower value produces a stronger center signal.

**Upmix Parameters for Ambient Signal Components**

- **Gain**
  The level of the ambient signal within the upmix in dB.

- **Front/Rear**
  Controls the front-rear balance of the ambience. In order to have more ambience in the back than in the front, pull down this slider. Note that the front-rear balance will be applied before the rotation, so “front” always corresponds to the direction of the stage.

- **Delay**
  This parameter delays the ambience signal in relation to the direct signal.

- **Low Pass**
  Controls the frequency in Hz of the low pass filter which is only applied to the ambience. The direct signal is not affected by this parameter.

Visualization of different Upmix parameters in the stage overlay
Global Parameters

- Upmix/Original
The “Original” signal corresponds to a regular stereo panning of the Object’s input signal, controlled just by the parameters “Stage Width” and “Rotation”. No additional upmix is performed on the “Original” stereo sound. Use the Upmix/Original slider to set the balance between the original stereo signal and the upmix signal.

- Bypass
This button can be used to compare the upmixed result with the unprocessed stereo signal. If bypass is active, the input stereo signals are placed in the front at -30° and +30° without any signal processing or rotation applied.

Parameter Sets
There are four predefined sets of upmix parameters that can be applied to the currently selected Upmix Object (Default, Pointed, Moist, Open). These four sets correspond to different upmix characteristics that can be applied quickly. Choose the parameter set you want to use in the “Set parameters” drop-down menu.

To store and restore a user defined upmix parameter set, the entries “Store user” and “Recall user” can be selected. The user set is global for all projects but will only be available until Nuendo is closed. It can also be used to copy parameters to other Upmix Objects or projects.

Note that a locked parameter will not be overwritten when a parameter set is applied.
GROUP OBJECT PARAMETERS

Group Objects have a slightly different set of parameters than Channel or Event Objects. While positioning is handled the same way as Channel and Event Objects, Groups have additional rotation and scale settings to address relative positioning of the group's members.

- Group Objects do not have Spread and Auto-Delay settings.

Rotation

The Rotation of a group alters the relative positions of the members of that group around the Group Object's center. This should not be confused with group's Angle which controls the position of the group object around the center point of the stage. The figure below shows how the rotation of a group affects its members. The group icon also reflects the rotation of the group by the position of the notch.

X and Y Scale

The X and Y Scale parameters affect the relative position of group members in both axes. By adjusting the X Scale parameter, members of a group will spread out or constrain together proportionally on the horizontal axis of the stage. The same is true for the Y axis scale parameter. This is expressed as a ratio. Values less than 1 reduce the distance between Objects while values greater than 1 (up to 100) increase the distance between Objects in the Group.
By pressing the join button, the X and Y Scale parameters are linked for circularly proportional scaling of group members.

When checked, the join button links the X and Y Scale parameters together for proportional scaling.

For more information on these Group Object parameters, please see “Group Object Automation” on page 34.

**IOSONO SPECIAL PARAMETERS**

The following settings are effective for using the SAW with an IOSONO system only (e.g. the IOSONO IPC 100 Spatial Audio Processor). However, you can access these parameters also in the multichannel version of the Spatial Audio Workstation, in case you like to prepare an IOSONO mix in a usual multichannel environment and transfer it to an IOSONO system later.
On screen

The “on screen” switch is used to always keep the position of an object that is visible on the screen consistent with the corresponding audio object. On playback, the Spatial Audio Processor considers the real dimension and position of the existent screen and corrects the position of the Object accordingly.

Ceiling

Setting the ceiling switch gives the rendering processor a hint that the particular Object is situated in the ceiling layer. These Objects will then be audible from above the audience, when they are placed or moved into the Audience Area.

Source Type

Each mono Event or Channel Object can radiate sound in two ways:

- **Point Source: a source with a constant position in space**

  Point Sources radiate spherically from a single point in space. For example, a car driving into a driveway is a Point Source. As the car moves across the driveway, the listener perceives changes in the sound. A listener in a different location on the driveway will hear the Point Source in a slightly different way. The same is true for Point Sources in the IOSONO system. Point Sources are useful when you want each listener to hear a more localized sound source. Listeners in different parts of the listening area will be presented with a different sonic image of the Point Source.

- **Plane Wave: a source with constant direction relative to each listener in the audience area**

  By contrast, Plane Waves appear to come from a general direction for all listeners. You could consider a Plane Wave to be a Point Source that is an infinite distance away from the listener. Planar sources are useful when you wish each listener to hear the same sonic image produced by that Object. Ambient sounds are particularly effective as Plane Waves.

  Each Object can be either a Point Source or a Plane Wave. Objects can change from Point Source to Plane Wave and back again using the automation features of the Spatial Audio Workstation.
SPATIAL AUDIO WORKSTATION AUTOMATION

INTRODUCTION

While placing static Objects using the Spatial Audio Workstation can be immersive and captivating. Moving objects around in real-time takes it to a whole other level. Every parameter of an Object can be automated in real-time using the powerful automation system. Objects can be write- and read-enabled just like channels in the Nuendo mixer. To write-enable an Object, check the write box next to its name in the Object list or use the shortcut Alt+W for selected Objects. By default, Read is also enabled when you put an Object in write mode. You can toggle the read status of an Object using the check box or shortcut Alt+R.

When an Object is write-enabled, the red W icon appears next to it in the Stage view along with the green R (read-enabled) by default. Also, the read and write buttons next to each Object parameter light up in green and red. Individual parameters may be read or write enabled or disabled individually by clicking on the buttons next to each parameter. You may also lock individual parameters of Objects by clicking on the padlock icon for that setting.

The write and read status of Objects in the Spatial Audio Workstation are not reflected in Nuendo. Automation using the Spatial Audio Workstation GUI does not need the Nuendo track to be write-enabled. In order to write automation, the Object must be placed in write mode from within the GUI window.
CREATING MOTION PATHS

Automation in the Spatial Audio Workstation is somewhat different than with other panning plug-ins due to the fact that the Spatial Audio Workstation is positioning Objects regardless of the amount of speaker channels present in the monitoring system. It's not simply the relative level of audio in various speaker channels that is being automated. The Spatial Audio Workstation actually renders the position of the audio signal to the current speaker configuration as set in “Project Settings” on page 3.

The basic component of Spatial Audio Workstation automation is called a motion path. A motion path is the pathway that an Object follows as it moves throughout the Stage. Motion paths can be simple straight lines or complex curves that meander around the Stage. Once created, Motion paths appear as yellow lines in the stage. There are four ways to create motion paths in the Spatial Audio Workstation:

- Using Real-time automation to draw complex curved paths
- Using Move automation to create simple straight paths
- Using Jump automation to create instant movements
- Drawing in X and Y values directly in Nuendo's automation lanes

A motion path in the stage
REAL-TIME AUTOMATION

Real-time automation is rather simple to do. Just write-enable any Object in the Object List, hit play and move the Object around the Stage as you desire. When you enable write mode in the Spatial Audio Workstation, automation read is also enabled for that object. Upon playing back, the object will follow the exact motion you performed. Any parameter of the Object can be automated in this manner.

THE SPATIAL AUDIO WORKSTATION AUTOMATION MODES

Touch
When operating in touch mode, automation data is written when touching a parameter-control or an object in the stage view. On release the control returns to the previously set value.

Auto latch
In auto latch mode writing of automation data starts on touching a parameter control or an object in the stage view and continuous until playback stop.

Prime latch
This mode is basically similar to auto latch except that the prime latch enabled parameter starts writing automation data instantly on playback. You can set a control to prime latch mode by toggling the „P“ button next to it.

To End
When this button is active in the Spatial Audio Workstation tools area, the last position of the Object when automating will be where the Objects remain until the end of the Nuendo project for Channel and Group Objects and to the end time of the audio event for Event Objects. Of course that can be amended with more automation, but for that pass, the Object will stay at the final point in the motion path until the end time for that Object.

- Nuendo projects using the Spatial Audio Workstation have an end time of 24 hours.

---

The SAW automation modes and the To End button in the tools palette
MOVE AND JUMP (KEYFRAME MODE)

The second method of creating motion paths and automation involves a step by step process whereby you create simple, straight motion paths and either have the Object move gradually (move) or instantly (jump) from the start to the end of the path.

Create Move Automation

Move automation allows you to have an Object move smoothly from one point to another in a straight line over time. To create a simple straight motion path using Move automation, follow these steps:

1. Create an Event or Channel Object
   While Move automation works with Group Objects, it is best to start with single objects for simplicity.

2. Place the Object at the desired start position on the Stage.
   Using the Object selection tool, drag the Object to the starting position.

3. Enter Keyframe Mode
   Either press the Keyframe Mode button in the tools area or use the Alt+H key command. This also creates a starting keyframe at the current time and position for the Object.

4. Move the Nuendo playback cursor forward in time.
   Move to the time when you would like the Object to reach to its destination.

5. Move the Object to a new destination on the Stage.

6. With the Object selected, press the Keyframe Move button.
   This defines the end of the motion path with another Control Point and Keyframe.

7. You will now see a yellow motion path that goes from the start to the end points similar to the figure below.
   When you play back, the object moves smoothly from the start of the motion path to the end during the specified time.

You can continue to create Move automation later in the timeline by repeating steps 4 through 7, creating new motion path segments.

Keyframe Tools
Creating Jump Automation

Jump automation works in much the same way as Move automation. The only difference is that the Object will jump instantly from one point to another instead of gradually. In order to create Jump automation, follow the same steps outlined for Move automation but replace the Move button with the Jump button. By following steps 4 through 6 repeatedly, you can create successive Jumps, each one having its own motion path segment. Moves and Jumps can be mixed together in one motion path.

NUENDO AUTOMATION LANES

The last method of creating and altering motion paths is by direct editing of the automation lanes in Nuendo. The position and motion of any object is represented in Nuendo by X and Y coordinates. Each axis has its own automation lane. By drawing in automation points in these lanes, motion paths will be changed in the Spatial Audio Workstation.
ANATOMY OF A MOTION PATH

Motion paths are made up of segments. Each Move or Jump automation an Object performs will create another motion path segment. These segments are connected to form a complete motion path. Real-time motion paths are made up of many segments that create complex curves. Each motion path can be edited to fine tune its shape and position. The Spatial Audio Workstation tools have three modes for editing Objects and their paths:

- **Object Selection**  
  *This is the default mode that the Spatial Audio Workstation opens into.*

- **Path Selection**  
  *This mode allows you to choose motion paths for editing.*

- **Motion Path Edit**  
  *You may only enter this mode once a motion path has been selected.*

**PATH SELECTION**

Path selection mode allows you to define a path or portion of a path for editing. Enable path selection in the Spatial Audio Workstation tools then click on a motion path. The path will turn blue and have black points at its start and end. The black points define what portion of the motion path to edit. They correspond to the left and right locators in Nuendo. If you click and drag one of these points, you will see the locator move in Nuendo’s timeline. The portion of the motion path that remains blue is selected for editing.
MOTION PATH EDIT

In order to edit the shape and position of the motion path, you must have a portion of a path selected and then press the Motion Path Edit button in the Spatial Audio Workstation tools. The selected portion of the path in blue will now change to display control points at the various curves in the path.

Each turn in the motion path has its own control point. Each control point can be moved about the stage freely, changing the shape of the motion path. Simply click and drag the control point to the desired location. By moving various control points, the shape of the entire motion path can be changed.

You may move more than one control point at a time by selecting multiple points and dragging them together.

You can insert additional control points to further alter the path’s shape by placing the mouse over the path where you would like a new control point and choose “Insert control point” from the contextual menu (right-click). This new control point can be moved as desired to create a new shape.

To delete a control point, place the mouse directly over the point and right-click to choose Delete from the contextual menu. You can also select more than one control point by shift+clicking multiple points. Simply press the delete key to remove all selected control points at once.

Control Point Handles

In addition to being able to move control points, the shape of the path around the point can be contoured. Each control point has one or two “handles” associated with it. These handles are used to change the shape of the motion path segment around the control point. By moving the handles, the curvature of the motion path changes.
In order to access these handles, two or more control points must be selected. White points will appear on top of the control point. These can be moved to change the path shape. Experimentation is the best way to get a feel for how this works. The figure below shows handles that have been moved in such a way as to create a smooth curve around a control point.

**Handles**

When a control point is in the middle of a motion path, it will have two handles associated with it. Each handle controls the shape of the line on either side of the control point. The way that the two handles interact with one another (control point interpolation) can be set in three ways:

- Corner
- Smooth
- Symmetric

In order to change the interpolation of handles, first select one or more control points. Then press one of the Control Point Interpolation buttons found in the Spatial Audio Workstation tools.

**Control Point Interpolation buttons in the tools palette**
**Corner Interpolation**

Corner interpolation allows each handle to be manipulated independently. This can create a sharp corner or a smooth curving turn as the path passes through the control point.

![Corner interpolation of handles](image)

**Smooth Tangent Interpolation**

Smooth interpolation forces the handles to remain opposite of each other around the control point, creating a smooth path through the point. However, each handle can be stretched inde-

![Smooth interpolation](image)
**Symmetric Tangent Interpolation**

Symmetric interpolation is much the same as Smooth except that the handles are linked together in direction and length, resulting in symmetric motion path shapes around the control point.

**LINEAR AND SPLINE MOTION PATH SEGMENTS**

Each motion path segment can have either a linear or a spline shape to it. By default, all motion path segments are created as spline segments. Spline segments allow the curving shape as defined by the handles for each control point. A linear segment is a straight line between points. Linear segments do not have control point handles.

In order to change a segment from spline to linear, you must select both the starting and ending control points that define that segment. Then from the edit menu, choose Motionline tool controls --> Linear segment, or press the Linear segment button. You will notice that the handles for those control points disappear in the Stage view.

To change back to a Spline segment, use the Spline button or menu option and the handles will return. This may be done for several contiguous segments if all the associated control points have been selected.

**The Linear and Spline buttons will change the segment’s shape between two control points**
AUTOMATION IN NUENDO

All three types of Spatial Audio Workstation automation (jump, move and real-time) create data that can be viewed and edited in Nuendo. Once you have created automation, right-click over the tracks list in the project window and choose “Show All Used Automation” to make all the Spatial Audio Workstation parameters visible in the Nuendo timeline that have automation encoded. Using the Automation Panel, you can press the “Show Used” button to display all automation lanes currently active for the Spatial Audio Workstation.

MONO OBJECT AUTOMATION

The position of any Object in the stage is represented in Nuendo as X and Y coordinates. Each axis has its own automation lane showing the position motion of that Object. In addition to that, all other parameters for these Objects each get automation lanes in Nuendo.

For mono Event and Channel Objects, the available parameters in Nuendo are:

- Volume
- LFE
- Delay (manual and auto)
- Spread
- Distance Dependend Volume Decay
- Distance Dependend EQ Decay
- Distance Dependend EQ cutoff Frequency
- X-axis value
- Y-axis value
- Source type (point source/plane wave)
- Ceiling on/off
- On Screen on/off
Upmix Objects have additional automation parameters:

- Dry/Wet
- Stage Width
- Divergence
- Ambience Gain
- Ambience Front/Rear
- Ambience Delay
- Ambience Low Pass
- Upmix/Original

GROUP OBJECT AUTOMATION

Group objects have a slightly different list of automated parameters.

- LFE
- X-axis value
- Y-axis value
- Rotation
- Scale X
- Scale Y
- Volume
- Delay (manual only)

The X and Y Scale parameters start with a default value of one (1) and represent a ratio of scaling. Values below 1 constrain the group members closer to the Group Object while larger values spread the members apart. X and Y scaling has a range of 0-100.

- In Nuendo, a scale value of one (1) is very close to the bottom of the automation track in the project window. It may look like a minimum value at first glance but if you draw in automation points that go to the bottom of the track, all the group members will be constrained to the center of that axis.
- Nuendo ignores the status of the X and Y scale-joining in the Spatial Audio Workstation. If the X and Y scales are joined, editing the scale value of one axis in Nuendo will not cause the other axis to follow the same changes.

The Rotation parameter has a default value of 0 degrees (up or north). As that value increases, the members of the group rotate around the center in a clockwise fashion until 180 degrees whereupon the values become negative and continue from -180 back to zero. Please note that as
the rotation of a group object changes, so do the angles of the scaling axes (X and Y). This figure illustrates how the X and Y axes are relative to the notch seen on the Group Object and not to the stage area itself.

Motion Paths of Group Members

When Objects are joined together with a Group Object, their motion on the Stage is governed by both their individual motion paths and the motion of the Group, including Rotation and Scaling. If you dissolve a Group Object that has automation written to it, Nuendo will ask if you wish to keep the automation for all the group’s members. If you choose to keep the automation, the motion paths of each member object will be updated to reflect the compound motion of both the group and member object to the new path. Even if no automation is written but the group changes the static position of the members, this dialog will pop up when dissolving the group.

If you choose not to keep the group’s automation data, each member will revert to its own motion path and position.
AUDIO TRACK CHANNEL AND EVENT MODES

By default, newly created Audio tracks in Nuendo are in the Channel Mode, thus creating a single Channel Object in the Spatial Audio Workstation. You may choose to switch this to Event Mode if you want to have multiple Event Objects instead. When switching from Channel to Event mode, all motion paths and other automation for the Channel Object is converted into Event Object automation for each event on the audio track.

Before you convert Channel Object automation into Event Object automation, you must first have audio events on the track. If there are no audio events on the track when you change modes, all automation will be lost! Any portions of the timeline that do not contain audio events will have no automation present when in Event Mode.

Conversely, you can change an audio track from Event to Channel mode. Doing so converts each Event Objects automation into one single Channel Object with the same automation. Since Event Objects can also be members of Group Objects, any group automation that affects the Event Objects will be consolidated into the new Channel Object automation, retaining the correct motion path and position for each audio source.

To change the mode of one or more Audio tracks, follow these steps:

1. Select one or more Audio tracks that are routed to IOSONO outputs.
   Only Spatial Audio Workstation enabled tracks can have their mode changed.

2. Choose the option under the Project menu, “SAW: Switch selected tracks to Event mode.”
   All automation that was applied to the Channel Object will now be applied to the events contained in the Audio track.
3. Check automation lanes to ensure that all automation was transferred correctly. *If there are no audio events on a track that is switched to Event mode, automation written in Channel mode will be lost. Areas in between audio events will not have automation.*

- When switching back to Channel mode, only automation from each Audio event will be transferred.

**ALTERING LAYERS AND GROUPS WITH AUTOMATION**

When altering the composition of layers and groups in the layers list using the drag and drop method, automation data will be affected if an Event Object is moved out of its parent group. For example, if an Event Object is moved from within a group on one layer to a new layer, a dialog will appear asking if you would like to transfer the group automation data including the static position of that Event. Transferring this group data will alter the Event’s motion path to reflect any change made by the group’s static position, rotation, scaling and motion path. Additionally, group volume, LFE level and delay will be added to the Event Object’s values in the transfer.

**Group automation transfer dialog**

**MOTION PATH VISIBILITY**

With many motion paths, the stage can become quickly over crowded and confusing. The visibility of motion paths can be controlled in four ways:

- **Path overall visibility**
  
  *Available from the View-->Path visibility menu, this option will turn off the visibility for all motion paths.*

- **Path playback visibility**
  
  *This option makes paths only visible when Nuendo’s transport is stopped. During playback, all paths disappear.*
• Individual path visibility check box in the layers list
  You can make an individual motion path invisible by un-checking it in the layers list. Each motion path is listed in the layers list and has both locking and visibility check boxes.

• Motion Path Fading
  Motion path fading allows the Spatial Audio Workstation GUI to only display the portion of the motion path that corresponds to the zoom level in Nuendo's project window.

Motion path check boxes in layers list

The path fading button in tools

Motion path fading is a convenient way to focus on only a portion of a complex motion path using the zoom function in Nuendo. By enabling motion path fading with the button in the tools palette or from the menu option, only the portion of motion paths that exist between the left and right boundaries of the project window will be seen. If they continue past those points, the lines will fade as seen in the figure below.
Motion path fading at zoom level